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QUESTION 20 
DRAG DROP 
 

You have the following Common Data Service entities: BusinessContracts and BusinessAccounts. 

You need to configure an N:N relationship between the two entities. 

Which three actions should you perform in sequence? To answer, move the appropriate actions from the 
list of actions to the answer area and arrange them in the correct order. 
 

Select and Place: 

 
 
Correct Answer: 

 
 

Explanation 
 

Explanation/Reference: 
Explanation: 
 

Step 1: Open the relationship tab of the BusinessContracts entity. 
View entity relationships 
From the Power Apps portal, select either Model-driven or Canvas design mode. 
Select Data > Entities and select the entity that has the relationships you want to view. 
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With the Relationships tab selected, you can select the following views: 
 

Step 2: Select Add relationship.. 
Create relationships 
While viewing entity relationships, in the command bar, select Add relationship and choose Many-to-many. 

Step 3: Select the BusinessAccounts entity as the related entity. 

Reference: 
https://docs.microsoft.com/en-us/powerapps/maker/common-data-service/create-edit-nn-relationships- 
portal 
 

QUESTION 21 
DRAG DROP 
 
You are an app builder for a medical office. The medical office uses activities to book appointments and 
business process flows to track patient status. The cleaning staff wants the app to connect directly to a 
Microsoft Excel workbook to track cleaning tasks. The office does not have access to reporting tools 
including Power BI. 
 
You need to create apps for the following groups of users. Apps must not require customizations or the 
use of additional products. 
 

 

Which type of app should you build for each group? To answer, drag the appropriate app types to the 
correct groups. Each app type may be used once, more than once, or not at all. You may need to drag the 
split bar between panes or scroll to view content. 
 

NOTE: Each correct selection is worth one point. 
 

Select and Place: 

 
 

Correct Answer: 
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Explanation 

Explanation/Reference: 
Reference: 
https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/embedded-canvas-app-guidelines 
 

https://global.hitachi-solutions.com/blog/canvas-vs-model-driven-apps 
 

QUESTION 22 
DRAG DROP 
 

You plan to create apps for a company. 
 

You need to identify the Power Platform tools required. 
 
What should you use? To answer, drag the appropriate tools to the correct requirements. Each tool may 
be used once, more than once, or not at all. You may need to drag the split bar between panes or scroll to 
view content. 
 

NOTE: Each correct selection is worth one point. 
 

Select and Place: 

 
 
Correct Answer: 

 
 

Explanation 
 

Explanation/Reference: 
Explanation: 
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Box 1: Canvas App 
 
Box 2: Model-driven app 
Model-driven app design is a component-focused approach to app development. Model-driven app 
design doesn’t require code and the apps you make can be simple or very complex. Unlike canvas app 
development where the designer has complete control over app layout, with model-driven apps much of 
the layout is determined for you and largely designated by the components you add to the app. 
 

Box 3: Power Automate 
Power Automate is a service that helps you create automated workflows between your favorite apps and 
services to synchronize files, get notifications, collect data, and more. 
 

Box 4: Power Virtual Agents bot 
When you create bots with Power Virtual Agents, you author and edit topics. 
 

Topics are discrete conversation paths that, when used together within a single bot, allow for users to have 
a conversation with a bot that feels natural and flows appropriately. 
 

Creating a bot with Power Virtual Agents is easy to do with the no-code authoring canvas, and there are a 
number of ways you can manage how topics interact, how you want the conversation to flow, and what it 
should feel like. 
 

Reference: 
https://docs.microsoft.com/en-us/power-virtual-agents/authoring-fundamentals 
 

https://docs.microsoft.com/en-us/power-automate 
 

QUESTION 23 
A company uses data loss prevention (DLP) policies. You have a Power Automate flow that posts Twitter 
mentions into a Microsoft SharePoint list. 
 

You are not able to activate the 

flow. You need to troubleshoot the 

issue. 

What are two possible reasons why you cannot activate the flow? Each correct answer presents a 
complete solution. 
 

NOTE: Each correct selection is worth one point. 

 
A. You are not assigned the Power Platform Admin role. 

B. You placed all connectors into the Business group within the DLP policy. 

C. You placed all connectors into the Non-Business group within the DLP policy. 

D. You are not assigned the Environment Admin role. 

 
Correct Answer: BD 

Explanation 
 

Explanation/Reference: 
Explanation: 
D: DLP policies are created in the Power Platform admin center. They affect Power Platform canvas apps 
and Power Automate flows. To create a DLP policy, you need to be a tenant admin or have the 
Environment Admin role. 
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B: This table describes how the DLP policy you created affects data connections in apps and flows. 

 

Note: Any connector that resides in the Non-Business data group—such as Outlook.com—won't share 
data with apps and flows by using SharePoint or Salesforce connectors. Facebook and Twitter connectors 
are altogether blocked from being used in any app or flow in non-test environments such as production or 
default environments. 
 

Reference: 
https://docs.microsoft.com/en-us/power-platform/admin/wp-data-loss-prevention 
 

QUESTION 24 
You are an app maker. You are creating a canvas app. 

You do not have access to Power BI. 

You need to add charts to the app. 
 
Which three chart types can you add directly to the canvas app? Each correct answer presents a complete 
solution. 
 

NOTE: Each correct selection is worth one point. 

A. pie 

B. area 

C. funnel 

D. column 

E. line 
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Correct Answer: ADE 
Explanation 
 

Explanation/Reference: 
Explanation: 
You can use line charts, pie charts, and bar charts to display your data in a canvas app. 
 
Add a bar chart to display your data: 
1. On the Home tab, add a screen. 
2. On the Insert tab, select Charts, and then select Column Chart. 

 
Reference: 
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/use-line-pie-bar-chart 
 

QUESTION 25 
Note: This question is part of a series of questions that present the same scenario. Each question 
in the series contains a unique solution that might meet the stated goals. Some question sets might 
have more than one correct solution, while others might not have a correct solution. 
 

After you answer a question in this section, you will NOT be able to return to it. As a result, these 
questions will not appear in the review screen. 
 

You are creating a canvas app that displays a list of accounts. 
 
Users must be able to select an account and view details for the account. The app must include a feature 
that brings the user back to the list of accounts. 
 
You add a blank screen named Screen_Accounts and add a gallery named Gallery_Accounts to the 
screen. You set the data source of Gallery_Accounts to Accounts and add another blank screen named 
Screen_AccountDetail. 
 

You need to complete the app. 

Solution: 

Add an edit form to Screen_AccountDetail and set the Default Mode of the form to View. Set the 
OnSelect property of Gallery_Accounts to Navigate(Screen_AccountDetail). 
Set the data source of the form to Accounts. Set 
the Item property of the form to Selected. 
Add a back icon on Screen_AccountDetail and set its OnSelect property to Navigate (Screen_Accounts). 
 

Does the solution meet the goal? 

 
A. Yes 

B. No 

 
Correct Answer: A 
Explanation 
 

Explanation/Reference: 
Explanation: 
View, edit, or create an item, save the contents, and reset the controls in an Edit form control. 
FormMode.View: The form is populated with an existing record but the user cannot modify the values of the 
fields. 
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This function is often invoked from the OnSelect formula of a Button or Image control. 
 
Reference: 
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/functions/function-form 
 

QUESTION 26 
Note: This question is part of a series of questions that present the same scenario. Each 
question in the series contains a unique solution that might meet the stated goals. Some 
question sets might have more than one correct solution, while others might not have a correct 
solution. 
 

After you answer a question in this section, you will NOT be able to return to it. As a result, these 
questions will not appear in the review screen. 
 

You are creating a canvas app that displays a list of accounts. 
 
Users must be able to select an account and view details for the account. The app must include a feature 
that brings the user back to the list of accounts. 
 
You add a blank screen named Screen_Accounts and add a gallery named Gallery_Accounts to the 
screen. You set the data source of Gallery_Accounts to Accounts and add another blank screen named 
Screen_AccountDetail. 
 

You need to complete the 

app. Solution: 

Add an edit form to Screen_AccountDetail and set the Default Mode of the form to New 
Set the OnSelect property of Gallery_Accounts to Navigate(Screen_AccountDetail). 
Set the data source of the form to Accounts. 
Set the Item property of the form to Selected. 
Add a back icon on Screen_AccountDetail and set its OnSelect property to Navigate 
(Screen_Accounts). 
 

Does the solution meet the goal? 

 
A. Yes 

B. No 

 
Correct Answer: B 
Explanation 
 

Explanation/Reference: 
Explanation: 
FormMode.New: the form is populated with default values and the user can modify the values of the 
fields. Once complete, the user can add the record to the data source. 
 

Reference: 
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/functions/function-form 
 

QUESTION 27 
Note: This question is part of a series of questions that present the same scenario. Each 
question in the series contains a unique solution that might meet the stated goals. Some 
question sets might have more than one correct solution, while others might not have a correct 
solution. 
 

After you answer a question in this section, you will NOT be able to return to it. As a result, these 
questions will not appear in the review screen. 
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You are creating a canvas app that displays a list of accounts. 
 
Users must be able to select an account and view details for the account. The app must include a feature 
that brings the user back to the list of accounts. 
 

You add a blank screen named Screen_Accounts and add a gallery named Gallery_Accounts to the 

screen. You set the data source of Gallery_Accounts to Accounts and add another blank screen named 
Screen_AccountDetail. 
 

You need to complete the app. 

Solution: 

Add a display form to Screen_AccountDetail. 
Set the OnSelect property of Gallery_Accounts to Navigate(Screen_AccountDetail). Set the 
data source of the form to Accounts. 
Set the Item property of the form to Selected. 
Add a back icon on Screen_AccountDetail and set its OnSelect property to Navigate 
(Screen_Accounts). 
 

Does the solution meet the goal? 

 
A. Yes 

B. No 

 
Correct Answer: A 
Explanation 
 

Explanation/Reference: 
Explanation: 
If you add a Display form control, the user can display all fields of a record or only the fields that you 
specify. 
 

Reference: 
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/controls/control-form-detail 
 

QUESTION 28 
HOTSPOT 
 

You are configuring security to enable users to analyze data by using Microsoft Excel templates. 
 
You create a security role named TemplateAdministrator and configure the role as shown below and 
assign the role to a user named User1. 
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Use the drop-down menus to select the answer choice that answers each question based on the information 
presented in the graphic. 
 

NOTE: Each correct selection is worth one point. 
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Correct Answer: 

 
 

Explanation 

Explanation/Reference: 
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